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MYOB RetailEnterprise Licence Agreement

IMPORTANT - SOFTWARE LICENCE AGREEMENT, READ THIS AGREEMENT CAREFULLY. This Software Licence Agreement 
defines the terms of sale and use of the MYOB RetailEnterprise software and related User Guide and explanatory materials 
(the Product) and is the Licence referred to on the packaging of the Product. HOWEVER, if the Licence Agreement 
contains anything of which you were not aware prior to purchasing the Product or do not agree to be bound by, DO NOT 
INSTALL THE SOFTWARE but return the Product to the reseller in its entirety and a full refund of the purchase price will be 
made. For the purpose of this agreement the Product shall include any modified versions and upgrades subsequently 
licensed to you. By installing and retaining the Product you are confirming that you have purchased the Product subject 
to this Licence and are bound by its provisions.

1 Scope of Licence
MYOB Technology Pty Ltd ('MYOB') through its local publishers, and distribution agents, hereby grants to you, the 
original purchaser, a paid-up, personal, non-exclusive and non-transferable Licence to use the Product subject to the 
terms and conditions of this Agreement.

a Single Computer Network You may use the Product on only one computer network that you own or operate at 
a single physical location and only then in respect of data files created by you or by another licensed user. You may 
transfer the Product from one computer to another that you own or operate on this network provided that you 
do not use or permit the usage of the Product on more than the licensed number of computers or computer ter-
minals at a time, nor permit the usage of the Product on more than one network at any one time, nor permit the 
Product to be used in respect of data files not created by you or by another licensed user. In the event of an 
upgrade or product exchange the Licence hereby granted is automatically transferred to the new version or prod-
uct. All rights in respect of the original product shall lapse and no further use of same shall be permitted.

b Copies You may not copy or duplicate the Product, except as necessary solely for archival purposes, Product 
error verification, or to replace 
defective storage media, provided you keep the original and the copies. You may not alter, decompile or 
disassemble the Product. You may not make copies of the related explanatory materials.

c Transfers You may not sub-license, lease, rent or lend the Product or otherwise transfer any of your rights under 
this Agreement. Subject to the prior written consent of MYOB and the agreement of the transferee to be bound 
by the terms of this Agreement, you may permanently transfer the Product (together with any backup copies you 
have made). However, you may not retain any copies of the Product.

d Term The Licence granted in this Agreement is effective until terminated. You may terminate it at any time by 
destroying the Product, together with all copies, or by returning them to MYOB. If you fail to comply with any 
term or condition of this Agreement, this Licence will terminate and, upon any such termination, you agree to 
destroy the Product, together with all copies, or to return them to MYOB. Termination of this Licence shall be in 
addition to and not in lieu of any other remedies available to MYOB. Where you have entered into a Subscription 
Agreement with MYOB in respect of your use of the Product, the Licence granted in this Agreement will terminate 
if the Subscription Agreement terminates.

e Protection and Security You agree to use your best endeavours and to take all reasonable steps to safeguard the 
Product to ensure that no unauthorised person has access to the Product and that there is no unauthorised 
copying or distribution of the Product.

f Subscription Sale If purchased under a subscription sale the right to use the software relies on you continuing to 
pay the monthly subscription fee.

2 Product Support
Where purchased under a Subscription Sale in respect of your use of the Product, your payment of the monthly 
subscription fee entitles you to ongoing support for the current version of the Product.

The initial purchase price may include a period of support notified to you by MYOB. On the expiration of this period, 
further support can be obtained at your expense.

3 Limited Warranty and Disclaimer
MYOB warrant that the media on which the Product is provided are free from defects in materials and workmanship 
under normal use for a period of 90 days from the date of your original purchase. Except for the limited warranty 
described above, the Product is sold 'as is', and you are assuming the entire risk as to its quality and performance. It 
is your responsibility to verify the results obtained from the use of the Product.

If during the 90-day limited warranty period, you discover physical defects in the media on which the Product is 
supplied, MYOB will replace it at no charge to you, provided you return the item to be replaced with proof of 
purchase to MYOB. THIS IS YOUR SOLE REMEDY. IN NO EVENT WILL MYOB BE LIABLE TO ANY PERSON FOR ANY 
DIRECT, INDIRECT, SPECIAL, INCIDENTAL, CONSEQUENTIAL OR SIMILAR DAMAGES, EVEN IF MYOB HAS BEEN 
ADVISED OF THE POSSIBILITY OF SUCH DAMAGES.

Some jurisdictions do not allow the exclusion or limitation of implied warranties or of liability for incidental or 
consequential damages, so the above limitations or exclusions may not apply to you. This warranty gives you specific 
legal rights and you may also have other rights that vary from state to state. In the event that any of the above 
limitations or exclusions are held to be unenforceable, MYOB's total liability shall not exceed the amount of the 
Licence fee you paid.
  3
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4 Entire Agreement
This Licence (and Subscription Agreement if applicable) constitutes the entire agreement between MYOB and you 
and any prior representations, statement or undertaking howsoever made are expressly cancelled. No amendment 
or modification to this Licence shall be valid unless it shall be in writing and signed by an authorised representative 
of MYOB.
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1  Getting Started
Welcome to MYOB RetailEnterprise—the extension to MYOB RetailManager that provides a 
competitive advantage to your multiple-outlet retail business. 

About this manual

This MYOB RetailEnterprise Shop User Guide provides you with the information you need to 
use the features and benefits of RetailEnterprise Shop. You may need to refer to the User Guide 
when:

getting started

setting up RetailEnterprise Shop

performing the regular, daily tasks in RetailEnterprise Shop

setting up and using RetailEnterprise Stock At Other Shops.

NOTE : MYOB RetailEnterprise or MYOB RetailManager Enterprise? MYOB RetailManager 
Enterprise is now referred to as MYOB RetailEnterprise.

Overview of MYOB RetailEnterprise

MYOB RetailEnterprise enables you to establish electronic communication between your 
shops and the central office of your business. In this way, you can receive information such as 
centralised product updates, while your central office collects a daily summary of sales and 
stock levels from the shops.

RetailEnterprise Shop interfaces with RetailManager and leaves you free to get on with 
operating your shop. RetailEnterprise Shop works behind the scenes and involves minimal 
extra effort in the shops. For example, the collection of sales and stock figures can be 
scheduled to occur at a quiet time for your shop, typically at night.

Using RetailEnterprise Stock At Other Shops, you can view stock holdings from other shops, 
perform searches on other stock holdings and, if required, display shop details, name, address 
and contact details. See Chapter 4, Using Stock At Other Shops, on page 51 for more 
information.
7
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Typical RetailEnterprise Shop model
The illustration below shows a typical model of how RetailEnterprise Shop is implemented in a 
retail business like yours. 

As the illustration shows, RetailEnterprise Shop enables your shops to send information to and 
receive information from the central office. 

About RetailEnterprise
The RetailEnterprise software is made up of two separate parts:

the Shop module installed in your shops 

the Central module installed in your central office. 

Each module is designed to perform different activities. The Central module, installed at your 
central office, is used to perform centralised product updates and to act as a messaging service 
to multiple shops. The Shop module, installed locally at each shop, is used to receive messages 
and receive and process centralised product updates for your shop.

Daily sales and stock figures

Centralised product updates

Messages

central office computer

Shop A

Shop B

Shop C
C H A P T E R  1 G E T T I N G  S T A R T E D



The illustration below shows the functions of each of these modules within RetailEnterprise.

Shop module

This module of RetailEnterprise usually runs behind the scenes on a computer in your shop. 
Occasionally, you may need to respond to events or messages initiated by staff in the central 
office of your organisation. You use the Shop module to:

receive messages broadcast from the central office

receive product updates from the central office

create summary information for the collection process that is launched in your central 
office

receive stock holding information from other shops in your network.

Central module 

central office staff use this module of RetailEnterprise to:

monitor the collection process that collects daily sales and stock data from shops

maintain details of every shop (including any at the central office)

maintain details of products

broadcast messages to shops (including any at the central office)

broadcast other shop stock holding information

generate reports based on the daily sales and stock data collected from shops.

Daily sales and stock figures

Centralised product updates

Messages

central office computer

Shop A

Shop B

Shop C

central office module
Collecting summary information from shops
Maintaining shop details
Maintaining product details
Dispatching messages and product updates to shops
Producing reports

Shop module
Receiving messages from central office
Receiving centralised product updates
Creating summary information for collection
O V E R V I E W  O F  M Y O B  R E T A I L E N T E R P R I S E   9
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Checklist for implementation

This section contains a checklist for implementing RetailEnterprise Shop. The checklist is 
included especially for first time users of RetailEnterprise Shop. We recommend that you talk to 
your central office before you follow the sequence of steps outlined in the checklist.

Implementation checklist—Shop

NOTE : Install Adobe Reader to view PDF versions of the user guides You will need to install 
Adobe Reader to view the PDF versions of the user guides provided with your software.
To install Adobe Reader, click Resources in the welcome window of the MYOB RetailEnterprise Shop 
v4 CD.

Step Action By who

1 Ensure you have the appropriate hardware and software to establish 
communications between your central office and shops. 
• For a dial-up connection between your central office and shops—a 

data/fax modem, cables and a dedicated phone line
• For a LAN/WAN connection—LAN connection cabling and software
• For email communication—a POP or IMAP email account and an 

Internet connection.

Hardware 
supplier, 
Telecomms 
provider

2 Is RetailManager already installed?
If yes, continue from step 4.

Shop manager

3 Implement RetailManager in your shop, as described in the 
MYOB RetailManager Getting Started guide and MYOB RetailManager User 
Guide.

Shop manager

4 Install RetailEnterprise Shop.
See ‘Installing MYOB RetailEnterprise Shop’ on page 11.

Shop manager

5 Understand your technical support options.
See ‘MYOB technical support’ on page 59.

Shop manager

6 Set up general settings for RetailEnterprise Shop.
See ‘Setting RetailEnterprise options’ on page 21.

Shop manager

7 Set up communications between central and shop, depending on your 
chosen communications method.
• See ‘Setting up email communication between your shops and your 

central office’ on page 24, ‘Setting up dial-up networking between 
your shop and your Central office’ on page 29, and the separate 
Communications Setup Guide which you can access from the Help 
menu.

central office staff 
or RetailManager 
Professional

8 Test your connection. Shop manager
C H A P T E R  1 G E T T I N G  S T A R T E D



Installing MYOB RetailEnterprise Shop 

System requirements
Check that your computer meets the following requirements. We strongly advise that you use 
computers that meet the recommended requirements. 

Registering MYOB RetailEnterprise v4
MYOB RetailEnterprise Shop is registered when you register the MYOB RetailEnterprise Central 
module.
For more information about how to register, see the Getting Started chapter of the MYOB 
RetailEnterprise Central User Guide.

Operating system Recommended: Windows® Vista Ultimate (Service Pack 1), Windows Vista Business 
(Service Pack 1), Windows XP Professional (Service Pack 3)
Minimum: Windows XP Professional (Service Pack 1) or Windows 2000 (Service 
Pack 4)

Processor Recommended: Pentium® 4 processor (or equivalent) at 1.5GHz or faster
Minimum: Pentium III processor (or equivalent) at 500MHz

Memory Recommended: 512MB RAM or more
Minimum: 256MB RAM

Hard disk Recommended: 10GB or more of free disk space
Minimum: 1GB of free disk space

Display Recommended: 1024x768 dpi resolution
Minimum: 640x480 dpi resolution

Communications Appropriate hardware and software to set up communications between your central 
office and shops. 
• For a dial-up connection between your central office and shops—a data/fax 

modem, cables and a dedicated phone line
• For a LAN/WAN connection—LAN connection cabling and software
• For email communication—a POP or IMAP email account and an Internet 

connection.

Printer A local or network printer to print reports.

Mouse and 
keyboard

Windows-compatible mouse and keyboard

Software MYOB RetailManager v10 must already be installed on the computer.

Backup solution We strongly recommend a backup solution such as a CD/DVD writer or a USB 
storage device.
I N S T A L L I N G  M Y O B  R E T A I L E N T E R P R I S E  S H O P   1 1
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Do you need additional shop licences?
When you first install and register MYOB RetailEnterprise Central, you are supplied with five 
shop licences. If you need to bring more shops online, you must purchase and register 
additional shop licences.

NOTE : Additional licences are only available for current versions of RetailEnterprise.

You can purchase additional shop licences by calling MYOB.

For more information about how to purchase and register additional shop licences, see the 
Getting Started chapter of the MYOB RetailEnterprise Central User Guide.

Before you install RetailEnterprise Shop 
Make sure you have installed and registered MYOB RetailManager v10. MYOB 
RetailEnterprise Shop v4 will not work unless you have installed this on your computer. 

Disable your anti-virus program. If you use an anti-virus program, disable it before you 
install this version.

To install RetailEnterprise Shop 

1 Before you start, close all open applications. This is very important for correct installation. 
You will need to restart your computer when the installation is complete.

2 Log in as an Administrator (for Windows Vista users), or as an Administrator or Power User 
(for Windows XP or 2000 users whose computers only allow people with administrator 
privileges to install programs).

NOTE : Logging into Windows Vista as a Standard user If you have the Administrator 
password, you may be able to log into Windows Vista as a Standard user. You can then install 
RetailEnterprise Shop.

3 Insert the MYOB RetailEnterprise Shop CD and wait a few moments. A welcome window 
appears.

If you are in... call...

Australia 1300 555 115

New Zealand 0508 123 123

Malaysia 1300 88 0883 or (603) 8991 0166

Singapore (65) 6505 6582

Hong Kong (852) 3402 9882
C H A P T E R  1 G E T T I N G  S T A R T E D



If a welcome window does not appear automatically:

The welcome window appears. If the welcome window still does not appear, double-click 
the autorun.exe file.

4 Select the installer:
[Australia and New Zealand] Click Install RetailEnterprise Shop. 
[Hong Kong, Malaysia and Singapore] Click Select RetailEnterprise Shop installer, and 
then select the installer for your country.

The Welcome to MYOB RetailEnterprise Shop v4 Setup window appears. 

5 Follow the onscreen instructions.

NOTE : Warnings If any warnings appear during installation, see ‘Troubleshooting your 
installation’ on page 14. 

6 When the Installation Complete window appears, click Finish.

Your computer will restart automatically. If your computer does not restart automatically, 
you should restart it manually.

When you install MYOB RetailEnterprise Shop, the installation process sets RetailEnterprise 
Shop to start automatically whenever you start the computer. To confirm that 
RetailEnterprise Shop is running, check if the RetailEnterprise Shop icon ( ) is in the 
system tray at the bottom of your computer desktop, as shown:

If the icon is not displayed in the system tray, you can start RetailEnterprise Shop from the 
Start menu in Windows. Click Start, choose Programs, then choose MYOB 
RetailEnterprise - Shop v4.

CAUTION : [Windows Vista users only] Allow RetailEnterprise Shop to accept incoming 
network connections When you first open RetailEnterprise Shop after installation, a Windows 
security alert may appear to tell you that some program features have been blocked by the 
Microsoft firewall. To unblock RetailEnterprise Shop and allow incoming network connections, 
click Unblock. If you do not see the security alert, you can add RetailEnterprise Shop as a Windows 
firewall exception.

NOTE : Install Adobe Reader to view PDF versions of the user guides You will need to install 
Adobe Reader to view the PDF versions of the user guides provided with your software. To install 
Adobe Reader, click Resources in the welcome window of the MYOB RetailEnterprise Shop CD.

Where to from here? Continue from step 5 in the ‘Implementation checklist—Shop’ table 
on page 10.

If you are using... do this...

Windows Vista 1 Go to the Start menu and click Computer.

2 Click your CD or DVD drive icon (usually labelled D:\ 
or E:\) in the right pane of the Computer window.

Windows XP or 2000 1 Go to the Desktop and double-click My Computer.

2 Double-click your CD or DVD drive icon (usually labelled D:\ 
or E:\) in the right pane of the Computer window.
I N S T A L L I N G  M Y O B  R E T A I L E N T E R P R I S E  S H O P   1 3
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Troubleshooting your installation
During the installation of RetailEnterprise Shop, it is possible that you may get the following 
warnings or error messages.

For help with resolving other installation issues, contact technical support. For more 
information see ‘MYOB technical support’ on page 59.

Starting MYOB RetailEnterprise Shop 

The installation process sets RetailEnterprise Shop to start automatically whenever you start 
the computer. When RetailEnterprise Shop starts for the first time, the following message 
appears.

If the following warning 
message appears...

do this...

Read Only File Detected Select the Don’t display this message again option and click Yes. The 
application will continue to install.

Locked File Detected Select the Don’t display this message again option and click Reboot. 
The application will continue to install.

Files Failing to Self-Register Click OK. This warning does not affect the installation of the software.
C H A P T E R  1 G E T T I N G  S T A R T E D



To connect to your RetailManager shopfront

1 Go to the File menu and choose Settings. The Settings window appears.

2 Click Browse. The Browse for Folder window appears.

3 Locate the folder where the shopfront is stored and click OK. 

NOTE : Check with your central office To ensure that you select the correct shopfront, check 
with the appropriate person in your central office.

The Settings window reappears with the path inserted.

4 Click Save. Don’t worry about Schedule or Sending Method yet. These are explained in 
the ‘Setting RetailEnterprise options’ on page 21.

The MYOB RetailEnterprise - Shop window appears.

5 Click the close icon ( ) to close the MYOB RetailEnterprise - Shop window.
S T A R T I N G  M Y O B  R E T A I L E N T E R P R I S E  S H O P   1 5
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2  Setting Up

This chapter describes how to set up MYOB RetailEnterprise Shop for your business. Before 
beginning this chapter, make sure you have installed MYOB RetailEnterprise Shop as described 
in ‘To install RetailEnterprise Shop’ on page 12.

This chapter explains how to:

set RetailEnterprise Shop options

set up email communication between your shops and your central office

set up dial-up networking between your shops and your central office for the following 
operating systems:

Windows Vista Ultimate
Windows XP Professional
Windows 2000.

To help you become familiar with RetailEnterprise Shop, the first part of the chapter describes 
some basic navigation techniques for RetailEnterprise Shop. 

Starting MYOB RetailEnterprise Shop

When you install MYOB RetailEnterprise Shop, the installation process sets RetailEnterprise 
Shop to start automatically whenever you start the computer. 

When you complete the installation of MYOB RetailEnterprise Shop, you must restart your 
computer. After the restart, RetailEnterprise Shop should be running. To confirm this, check if 
the RetailEnterprise Shop icon ( ) is in the system tray at the bottom of your computer 
desktop, as shown:

If the icon is not displayed in the system tray, you can start RetailEnterprise Shop from the Start 
menu in Windows. Click Start, choose Programs, then choose MYOB RetailEnterprise - 
Shop v4.
1 7
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Navigating in RetailEnterprise Shop

This section describes the basics of navigating your way around MYOB RetailEnterprise Shop. 
The basics of navigation include the use of:

common Windows® features such as tabs, tables, buttons, list fields and 
checkboxes—these mainly involve using the mouse

fields for data entry and display

keyboard features such as shortcut keys.

If you’ve used Windows before, you will already be familiar with most of the techniques you 
need to navigate in RetailEnterprise Shop.

Common Windows features

RetailEnterprise Shop window example

The illustration below shows the title bar, a grid, button and the message bar:

NOTE : To display the example window (Products window) To display the example window 
above, go to the Information menu and choose Products.

Title bar

The title bar identifies the product and function of the current window.

Message bar Button

Grid

Title bar
C H A P T E R  2 S E T T I N G  U P



Grids 

A grid is an arrangement of data with two or more columns in which the information in the 
first column relates specifically to the information in the other column or columns. 

Buttons

Buttons are provided for different functions. For example, clicking Commit (shown below) 
saves data to the database. 

Message bar

The message bar displays information relevant to the current field. In RetailEnterprise Shop, 
most windows have a message bar at the bottom of the window as shown below. 

The field information in the message bar changes as you move from field to field.

Checkboxes

Checkboxes let you select or deselect options. You can either:

select to turn on an option or 

deselect to turn off an option. 

You can select more than one checkbox when there are multiple checkboxes, if applicable. 

Tabs 

Tabs enable you to access many different options or functions from the same window. 

Types of fields
There are various types of fields in RetailEnterprise Shop which are used for either entering data 
or displaying information. Fields that are used to enter data are usually referred to as input 
fields, while fields that are filled by the system are referred to as display fields.

Text fields A text field enables you to enter a combination of letters, numbers or special 
characters. If the field already contains text, you can delete the text, change it or overwrite it 
completely. 

List fields A list field enables you to select a valid entry from a list of available options or 
entries. The list is displayed in either a small, fixed window that you can scroll to select the 
option you need, or from a drop-down list you have to activate. 

Drop-down lists show a list of available options for a field. To display a drop-down list, click the 
arrow to the right of the field as shown below:

While in some list fields you can only select from the list of available options, in other fields you 
can either select from the list or type a new entry that is not in the list.
N A V I G A T I N G  I N  R E T A I L E N T E R P R I S E  S H O P   1 9
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Keyboard shortcuts
Some RetailEnterprise Shop functions can be performed using standard keyboard shortcuts; 
others are specific to RetailEnterprise Shop.

STANDARD NAVIGATION KEYS

FUNCTION KEYS

TRANSFERS MENU COMMANDS

TOOLS MENU COMMANDS

Closing a window
In RetailEnterprise Shop there are three ways to close a window:

Click Close

Press ESC

Click the close icon ( ) in the top right corner of the window.

Press … To …

TAB Move to the next step

ENTER Move to the next step

SHIFT+TAB Move back one step

ESC Close the current window

SPACEBAR Select an option in a window

¦ (Up arrow) Move up in a list or grid

Ø (Down arrow) Move down in a list or grid

Press … To …

F1 Open the Help (from any window)

Press … To …

CTRL+A Open the Transfer Audit window

Press … To …

CTRL+E Open the Connection Event Logs window
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Setting RetailEnterprise options

These settings are essential to the correct operation of MYOB RetailEnterprise Shop. The 
settings involve specifying:

the time at which the summary information file of your daily sales and stock figures should 
be created

the shopfront database from which the summary information will be accessed

the method used to send and receive information between your shops and your central 
office location.

Workflow
Each day, each shop (including your own) that is part of a wider RetailEnterprise network 
creates a summary file that contains information about the shop’s daily sales and stock figures. 

At a set time (typically at night) your central office starts a collection process using 
RetailEnterprise Central. If you are using the direct dial-up method of communication between 
shops and central office, this process might include establishing an electronic communications 
connection with each shop. The summary file from each shop is collected and processed by 
RetailEnterprise Central.

The collection process relies on summary information already having been processed at your 
shop location, ready to be collected by RetailEnterprise Central.

It is important that you set MYOB RetailEnterprise Shop to create this summary information file 
before the collection process from RetailEnterprise Central begins.

It is also important that you contact your central office to determine the appropriate time for 
your shop to create the summary information file. 

Communication methods There are three methods that RetailEnterprise and 
RetailEnterprise Shop can use to communicate. These methods are:

through direct dial-up communication (using a modem)

over a local area network (LAN) or wide area network (WAN)

via email.

Communications via direct dial-up or over a LAN/WAN are initiated and controlled by 
RetailEnterprise Central from your central office location. 

Communication via email is not controlled by RetailEnterprise Central, as the information is 
sent by RetailEnterprise Shop to the email address of your central office. Each party can only 
receive messages and updates when they are online (that is, connected via their ISP). central 
office and your shops do not need to be connected to each other simultaneously. If you will be 
using third-party email software, the shop summary file is automatically placed in the Outbox 
but can only be sent when the email software is online.
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To set up your RetailEnterprise Shop options

CAUTION : Proceed only after checking with your central office.

1 Double-click the RetailEnterprise Shop icon ( ) in the system tray at the bottom of your 
computer desktop. The MYOB RetailEnterprise - Shop window appears.

If the icon is not displayed in the system tray, you can start RetailEnterprise Shop from the 
Start menu in Windows. Click Start, choose Programs, then choose MYOB 
RetailEnterprise - Shop v4.

2 Go to the File menu and choose Settings. The Settings window appears.

Set the schedule

3 In the Last Summarised Date field, click the down arrow and select the required date from 
the calendar. 

When you are setting up MYOB RetailEnterprise Shop for the first time, you should set the 
date when you first started using RetailManager. 

This means that the first summary file created for your shop will contain all information 
prior to installing RetailEnterprise Shop.

The Settings window has three groups.

A Schedule Select the date and time for RetailEnterprise to create your summary 
information file for the next collection process. See ‘Set the schedule’ 
below.

B Collect 
Information from

Select the correct shopfront for the collection process. See ‘Select the 
shopfront’ on page 23.

C Communication 
Method

Select the method you will use to establish electronic communications 
between your shops and your central office. See ‘Choose your 
communication method’ on page 24.

A

B

C
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4 In the Daily Summary Time field, enter the time you want to create the summary file. You 
should set a time that is after your trading hours and before the collection process from 
your central office begins. Check with your central office to make sure you enter the right 
time.
a Click to select the part of the time you want to change—hours, minutes or seconds. 
b Type or select the relevant time using the up and down arrows.

At the time specified in the Daily Summary Time field, MYOB RetailEnterprise Shop will 
recreate summarised shop data for the period from midnight on the entered date up to the 
current date.

Select the shopfront

5 Is the correct shopfront displayed in the RetailManager Shopfront field?
If yes, go to ‘Choose your communication method’ on page 24.
If no, go to the next step.

6 Click Browse. The Browse for Folder window appears.

7 Use the Browse for Folder window to locate the required shopfront database folder.

NOTE : Check with your central office Check with the appropriate person in your central office 
to ensure that you select the correct shopfront folder.

8 Select the required folder and click OK.

If you have selected a folder with a valid RetailManager database, the Browse for Folder 
window closes and the Settings window appears with the path and name of the selected 
shopfront in the RetailManager Shopfront field. Go to ‘Select the shopfront’ above.

If the folder you selected does not contain a valid RetailManager shopfront, a 
RetailManager warning message appears.

9 Click OK.

10 Repeat the procedure from step 6 above.
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Choose your communication method

11 Do one of the following:
If RetailEnterprise Central uses dial-up or LAN/WAN to communicate with your shop, click 
Controlled from Central.
If RetailEnterprise Central uses email to communicate with your shop, click Use E-mail. 
Then, see ‘Setting up email communication between your shops and your central office’ 
below for instructions on configuring your email account.

12 Click Save to save the settings for your shop.

13 Minimise the MYOB RetailEnterprise Shop window to continue running the application 
in the background. You can restore the window by double-clicking the RetailEnterprise 
Shop icon ( ) in the system tray at the bottom of your computer desktop.

Setting up email communication between 
your shops and your central office

NOTE : MYOB RetailEnterprise emails In this section, the term ‘email communication’ refers to 
sending and receiving MYOB RetailEnterprise messages and updates using your email account. 
MYOB RetailEnterprise does not handle other email messages.

You can set up email communication between your shops and your central office in two ways:

Using MYOB RetailEnterprise’s in-built email functionality—if you have an email 
account, you can enter your account settings directly into MYOB RetailEnterprise. MYOB 
RetailEnterprise will then be able to send and receive messages and updates using your 
email server. 

To use this method, you will need an email account that uses either POP or IMAP protocols. 
You will also need to find out settings such as the incoming and outgoing server addresses. 
Contact your Internet or email service provider to find out these details.

Using third-party email software—if you already have separate email software set up and 
configured, you can specify that MYOB RetailEnterprise use this software for 
communication. Your email software will need to be running and your computer online for 
RetailEnterprise to be able to send and receive messages and updates.

To use this method, you will need an email software that is MAPI-compliant. For example, 
software such as Microsoft Outlook, Microsoft Outlook Express, Eudora and Lotus Notes 
are MAPI-compliant. To find out whether your software is compliant, contact your software 
supplier. 
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To set up email communication

To specify email settings in RetailEnterprise Shop

Before you start

1 Double-click the MYOB RetailEnterprise Shop icon ( ) in the system tray at the bottom of 
your computer desktop. The MYOB RetailEnterprise - Shop window appears.

If the icon is not displayed in the system tray, you can start RetailEnterprise Shop from the 
Start menu in Windows. Click Start, choose Programs, then choose MYOB 
RetailEnterprise - Shop v4.

2 Go to the File menu and choose Settings. The Settings window appears.

Step Task See

1 In RetailEnterprise Central, specify email settings The MYOB RetailEnterprise 
Central User Guide

2 In RetailEnterprise Central, enter the email addresses for every 
shop that uses email as the communication method

The MYOB RetailEnterprise 
Central User Guide

4 At every shop that uses email, open RetailEnterprise Shop and: 
• enter the email address of your central office 
• specify email settings for the shop
• test the connection

See ‘To specify email 
settings in RetailEnterprise 
Shop’ below

For this method... Check this...

[If you use Vista, or XP Service 
Pack 2 or 3]
Allow RetailEnterprise Shop to 
accept incoming network 
connections

When you first open RetailEnterprise Shop after installation, a 
Windows security alert may appear to tell you that some program 
features have been blocked by the Microsoft firewall. To unblock 
RetailEnterprise Shop and allow incoming network connections, click 
Unblock.
If you do not see the security alert, you can add RetailEnterprise Shop 
as a Windows firewall exception by doing the following.
• Go to the Control Panel and double-click Security Center
• Click Windows Firewall
• Click Allow a program through Windows Firewall
• Add RetailEnterprise Shop as an exception to the firewall.

Entering your email account 
settings directly into MYOB 
RetailEnterprise

Check that you have all the information required to set up your 
account. Contact your Internet or email service provider to find out 
the following information:
• incoming server address
• outgoing server address
• your account user name and password
You should also check if any advanced settings are required. For 
example, there may be a specific port number you need to specify.
Further, if you use a dial-up connection to connect to the Internet, 
check that you have configured your connection.

Specifying third-party email 
software

Check that your software has been set up correctly and that you are 
able to send and receive emails.
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3 Click Use E-mail and type the email address used by RetailEnterprise Central to receive 
summary information from your shop. Make sure you confirm the email address used with 
your contact at your central office location.

4 If you want to check for RetailEnterprise Central messages regularly, for example, every five 
minutes, select the Regularly check for new E-mails from Central every x minutes 
option and enter the interval (in minutes).

NOTE : If you are using third-party email software, this is the interval at which 
RetailEnterprise checks the software’s inbox The interval at which the email software 
actually connects to the Internet and downloads new emails is determined by the settings within 
the software.

5 Click E-mail Settings. The E-mail Settings window appears.
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6 Choose how you want to send and receive MYOB RetailEnterprise messages and updates:
If you want to enter your email settings directly into MYOB RetailEnterprise, select the 
Specify e-mail settings below option. Continue with step 7 below.
If you want to use third-party email software, select the software from the Use E-mail 
Program drop-down list. Continue with step 13 on page 28.

7 Choose whether your email account is a POP account or an IMAP account. 

8 In the RetailEnterprise Shop E-mail Settings section, enter your email server addresses 
(incoming and outgoing), your email address, and your account’s username and 
password. Contact your Internet or email service provider if you do not have this 
information.

9 Click Advanced. The Advanced E-mail Settings window appears.

10 Check if the settings in the Outgoing Server Settings and Port Settings tab need to be 
changed for your email account and make any necessary changes. 

Contact your Internet or email service provider if you are unsure whether you need to 
change the default options. 

11 Click the Connection tab. Choose one of the following options:
Never dial a connection—choose this option if you are online all the time (such as in a 
broadband connection) or if you are on a LAN or WAN network. You can also choose this 
option if you do not want RetailEnterprise to automatically connect to the Internet.
Dial whenever a network connection is not present—choose this option if you use a 
dial-up connection to connect to the Internet and you would like RetailEnterprise to 
automatically dial this connection. You will need to select the dial-up networking 
connection you want to use.

NOTE : IMPORTANT: Remember to configure your dial-up connection You will need to 
configure the properties of your dial-up networking connection in Windows:
- If you want RetailEnterprise to automatically dial up, ensure that you have saved your 
username and password and have set up the connection to connect automatically.
- If you want the dial-up connection to disconnect automatically after RetailEnterprise has 
finished sending the updates and messages, you will need to specify an appropriate idle time.
For more details about configuring dial-up networking connections, consult the Windows 
help.
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12 Click OK. The E-mail Settings window reappears.

13 Test your connection:
a Ensure that your computer is online. 
b If you chose to use third-party email software in step 6 on page 27, ensure that it is 

running.
c Click Test Connection.

A Test E-mail Settings window, similar to the one below, appears. 

14 The Test E-mail Settings window shows the status of each task: 
If all the tasks appear with a ‘Completed’ status, the test was successful. Click Close to 
close the Test E-mail Settings window. Continue with step 15 below.
If one or more of the tasks have a ‘Fail’ status, the test was not successful. Click Close to 
close the Test E-mail Settings window. Check that you have entered the correct email 
settings in the E-mail Settings window, or, if you’re using third-party email software, if 
your email software is configured correctly and is running. Then, repeat the test (step 13 
above) until you achieve a successful connection.

15 In the E-mail Settings window, click OK.
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Setting up dial-up networking between your 
shop and your Central office

NOTE : Dial-up networking These procedures, such as setting up user accounts and assigning 
security levels, assume a knowledge of Windows communications protocols and administrative 
functions. 
It is essential that these procedures are performed correctly, so if you do not feel confident about 
this, we strongly recommend you consult an MYOB RetailManager Professional. 
However, complete information and instructions are provided in the RetailEnterprise Communications 
Setup Guide which you can access from the Help menu.

This section provides brief guidelines for setting up the communications options for 
RetailEnterprise Shop in the following operating systems:

Windows Vista Ultimate

Windows XP Professional

Windows 2000.

Before you can set up communications options you must first install RetailEnterprise in your 
central office and shops. 

When you choose to use dial-up as your method of connecting between RetailEnterprise 
Central and RetailEnterprise Shop, you must set up and configure a dial-up network 
connection at your Central location, and then set up and configure a dial-up network 
connection at each of your shops.

It is essential that you complete the procedures to ensure that you benefit from the additional 
features provided by RetailEnterprise. These additional features involve connecting your 
central office to your shops using dial-up networking.

The procedures for setting up dial-up network connections vary with each version of the 
Windows operating system. 

Before you start 
Make sure that:

your modem has been installed and configured according to the modem manufacturer’s 
instructions

you have installed MYOB RetailEnterprise Shop

you are logged in to your computer as an Administrator (for Windows Vista users), or as an 
Administrator or Power User (for Windows XP or 2000 users whose computers only allow 
people with administrator privileges to install programs)

NOTE : Logging into Windows Vista as a Standard user If you have the Administrator 
password, you may be able to log into Windows Vista as a Standard user. You can then set up 
dial-up networking.

you have the appropriate Windows operating system installation CD available (You might 
need your Windows installation CD to install Windows networking components.)
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Setting up in Windows Vista Ultimate

NOTE : Windows Vista The steps for setting up dial-up communications may vary according to the 
edition of Windows Vista you are using. The method described here is for Windows Vista Ultimate, 
using the Classic View of the Control Panel.

Step Action Comments

1 Allow RetailEnterprise 
Shop to accept 
incoming network 
connections

When you first open RetailEnterprise Shop after installation, a 
Windows security alert may appear to tell you that some program 
features have been blocked by the Microsoft firewall. To unblock 
RetailEnterprise Shop and allow incoming network connections, click 
Unblock.
If you do not see the security alert, you can add RetailEnterprise Shop 
as a Windows firewall exception by doing the following.
• Go to the Control Panel and double-click Security Center
• Click Windows Firewall in the left pane
• Click Allow a program through Windows Firewall
• Add RetailEnterprise Shop as an exception to the firewall.

2 Set Network ID options Give computer a meaningful name—usually decided by central office

3 Set up a user account • Set up new user with a meaningful name such as ‘RetailManager’
• Set account type as Standard User
• Set password.

4 Set up dial-up 
connection options

• Go to the Control Panel and click Network and Sharing Center.
• Click Manage network connections.
• Press ALT to display the menu bar. Go to the File menu and select 

New incoming connection.
• Select the user accounts that you want to allow access to the 

computer and network. Make sure you select the account you 
added in step 3.

• Select the Through a dial-up modem option, and select your 
modem.

• Click Allow access.
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Setting up in Windows XP Professional

NOTE : Windows XP There are many variations of the Microsoft Windows XP operating system and 
the steps for creating a dial-up connection vary accordingly. The method described here is for 
Windows XP Professional Classic. Your version may be slightly different.

Setting up in Windows 2000

Step Action Comments

1 [If you use Service 
Pack 2 or 3]
Allow RetailEnterprise 
Shop to accept 
incoming network 
connections

When you first open RetailEnterprise Shop after installation, a 
Windows security alert may appear to tell you that some program 
features have been blocked by the Microsoft firewall. To unblock 
RetailEnterprise Shop and allow incoming network connections, click 
Unblock.
If you do not see the security alert, you can add RetailEnterprise Shop 
as a Windows firewall exception by doing the following.
• Go to the Control Panel and double-click Security Center
• Click Windows Firewall
• Click Allow a program through Windows Firewall
• Add RetailEnterprise Shop as an exception to the firewall.

2 Set Network ID options Give computer a meaningful name—usually decided by central office

3 Set up a user account • Set up new user with a meaningful name such as ‘RetailManager’
• Set account type as Limited
• Set password.

4 Set up dial-up 
connection options

• Select Set up an advanced connection
• Select Accept incoming connections
• Select modem
• Select Do not allow virtual private connections
• Allow new user to have permission to connect to this computer
• Set Networking software as Internet Protocol (TCP/IP)
• Accept default name for the new connection.

Step Action Comments

1 Set Network ID options Give computer a meaningful name—usually decided by central office

2 Set up user options • Add new user with name such as ‘Manager’—leave Full Name 
and Description blank

• Set password
• Set level of access to Restricted user.

3 Set up dial-up 
connection options

• Make new connection of type Accept incoming calls
• Select modem
• Set Do not allow virtual private connections
• Set new user to be allowed to connect to this computer
• Set Networking component to TCP/IP
• Accept default connection name. 
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3  Using 
RetailEnterprise 
Shop

This chapter describes the few tasks that you may have to carry out in MYOB RetailEnterprise 
Shop. These tasks may only need to be carried out occasionally. 

As mentioned before, RetailEnterprise Shop mostly works behind the scenes, and involves little 
extra effort in your shop.

The following tasks are described in this chapter:

working with messages

receiving product updates from your central office

creating the summary information file for collection

viewing the history of transfers between your shop and your central office

viewing the connection event log

backing up your data.

Messages

With MYOB RetailEnterprise Shop, you can receive messages sent electronically from your 
central office. These messages are used to inform you of a coming event or action that affects 
your shop. 

For example, your central office might send a message to your shop to notify you that there 
are centralised product updates ready to be dispatched. In this case you would need to take 
the appropriate action to receive the product updates (as described in this chapter).

When a message is sent by your central office to your shop, RetailEnterprise Shop notifies you 
by opening the Shop window. In the window, the New Messages folder shows the new 
messages that have arrived.

This section contains procedures that show you how to:

view message details

print messages

delete messages.
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Open RetailEnterprise Shop To perform the tasks in this section, you must have the 
RetailEnterprise Shop window open. To open the this window, double-click the 
RetailEnterprise Shop icon ( ) in the system tray area of the Windows task bar.

NOTE : RetailEnterprise Shop should always be running When you start the computer on which 
RetailEnterprise Shop is installed, RetailEnterprise Shop should start and remain active, running in the 
background. When RetailEnterprise Shop is active, an icon is displayed in the system tray, normally 
on the right side of the Windows task bar. 

If RetailEnterprise Shop is not running, you can start it manually from the Start menu in Windows. 
Click Start, choose Programs or All Programs, then select MYOB RetailEnterprise - Shop v4 from 
the displayed list.

To read a message

To read a message and take further action if required, perform the following steps:

1 Open RetailEnterprise Shop. The RetailEnterprise - Shop window appears.

Messages that you receive from central office are listed in the lower area of the window.

2 Do one of the following to read the message:
Select the message and press ENTER.
Select the message and click View Message.
Double-click the message.

The Message Details window appears.
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To print a message

1 Select the message you want to print.

2 Do one of the following to display message details:
Select the message and press ENTER.
Select the message and click View Message.
Double-click the message.

The Message Details window appears.

3 Click Print. The following message appears.

4 Do one of the following:
Click Yes to print the message on 40-column-wide receipt paper.
Click No to print the message on A4 size paper—if you have a default printer connected.
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To delete a message

1 Select the message you want to delete.

2 Do one of the following to display the message details:
Select the message and press ENTER.
Select the message and click View Message.
Double-click the message.

The Message Details window appears.

3 Click Delete. The selected message is deleted. 

Creating summary information for collection

The collection process occurs when RetailEnterprise Central in your central office collects a 
summary file of sales and stock figures from your shop. The summary file is automatically 
created at a set time (see ‘Set the schedule’ on page 22).

However, there may be times when your central office asks you to trigger the creation process 
manually in your shop prior to collection, for example, if the previous night’s collection from 
your shop was unsuccessful. 

Open RetailEnterprise Shop To perform the tasks in this section, you must have the 
RetailEnterprise Shop window open. To open the this window, double-click the 
RetailEnterprise Shop icon ( ) in the system tray of the Windows task bar.

NOTE : RetailEnterprise Shop should always be running. When you start the computer on which 
RetailEnterprise Shop is installed, RetailEnterprise Shop should start and remain active, running in the 
background. When RetailEnterprise Shop is active, an icon is displayed in the system tray of the 
Windows task bar. 

If RetailEnterprise Shop is not running, you can start it manually from the Start menu in Windows. 
Click Start, choose Programs or All Programs, then select MYOB RetailEnterprise - Shop v4 from 
the displayed list.
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To manually create a summary file for the current day

1 In the taskbar of the computer desktop, double-click the RetailEnterprise Shop icon ( ) in 
the right-hand corner. The MYOB RetailEnterprise - Shop window appears.

2 Go to the File menu and choose Summarise now. The stock holdings and sales summary 
information for the current day are collated and a message appears when the process is 
complete.

3 If you communicate with central office via a dial-up or LAN/WAN connection, the 
summary file will automatically be sent the next time central office collects data from your 
shop. 

If you are using email as your communication method, the summary file will be sent the 
next time your computer goes online. Note that if you have chosen to use third-party email 
software with RetailEnterprise, your email software will also need to be online before the 
summary file information can be sent.

To manually create a summary file for a prior period

NOTE : Check with your central office before continuing.

1 In the taskbar of the computer desktop, double-click the RetailEnterprise Shop icon ( ) in 
the right-hand corner. The MYOB RetailEnterprise - Shop window appears.

2 Go to the File menu and choose Settings. The Settings window appears.

The Last Summarised Date field displays the date when your shop’s sales and stock data 
were last summarised (prior to collection by your central office). You have the option to 
change this date and re-create your summarised shop data from the changed date. 
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3 In the Last Summarised Date field, click the down arrow to display the calendar window.

Select the required date in the calendar window. You can select a past date or today’s date 
but not a future date.

At the time specified in the Summary Start Time field, RetailEnterprise Shop will re-create 
summarised shop data for the period from midnight on the changed date up to the 
Summary Start Time.

For example, if you select today’s date, the creation of summary data will start from the 
time you specify in the Summary Start Time field. However, if you select a date in the past, 
the collection process will create summary data from that date until today’s date.

4 In the Summary Start Time field, change the time to when you want the summary file to 
be created.

NOTE : If the time in the Summary Start Time field has already passed, RetailEnterprise Shop 
starts creating the file immediately. The status bar shows the dates that are included in the file of 
summary information.

5 Make sure the correct shopfront is displayed in the RetailManager Shopfront field.

See ‘Select the shopfront’ on page 23 for information on how to select a shopfront to be 
summarised.

6 Click Save.

NOTE : Creating the summary file At the time specified in the Summary Start Time field, the 
file of summary information is created from the date specified in the Last Summarised Date 
field. 

7 Click the close icon ( ) to close the Shop window.
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Viewing the history of transfers between your 
shop and your central office

The Transfer Audit function allows you to view the communications history between your 
shop and central office.

To display all transfers between your shop and central office

1 Go to the Transfers menu and choose Transfer Audit. The Transfer Audit window 
appears.

Audit Filters

• Transferred 
Date From

Click the drop-down arrow to display a calendar. Select the date for the 
beginning of your search.

• End Date Click the drop-down arrow to display a calendar. Select the date for the end of 
your search.

• Message 
Type

Click the drop-down arrow to nominate the type of messages you are searching 
for. You can choose from the following message types, or choose (All).
• SAS—Sales Summary
• STL—Stock Holding Levels
• STC—Product Updates
• MSG—Messages
• OSL—Other Shop Stock Levels
• SHP—Shops
• SUP—Supplier Updates
• LST—Product Lists
• SST—Set Summary Start Time.

• Status Click the drop-down arrow to nominate the status of the messages you are 
searching for, for example, Pending, Confirmed, etc.
V I E W I N G  T H E  H I S T O R Y  O F  T R A N S F E R S  B E T W E E N  Y O U R  S H O P  A N D  Y O U R  



4 0   
2 Click Refresh to apply your search criteria. The results are displayed in the grid.

3 If the audit indicates that there were some connections that were unsuccessful, you should 
find the cause by:

checking the event log—see ‘To view the connection event log’ on page 41.
checking the computer connection details for your shop. This is done from central office. 
See the Using RetailEnterprise Central chapter of the MYOB RetailEnterprise Central User 
Guide.
contacting an individual shop to determine if the computer and modem are correctly 
connected.

4 Click Close to close the Transfer Audit window.

Viewing the connection event log

This section describes how you view the connection event log that MYOB RetailEnterprise 
Shop maintains. The connection event log provides a record of the sequence of events 
involved each time RetailEnterprise Shop connects to central office to send or receive 
information.

This is especially useful for verifying if the process has been successful. 

During the collection process, RetailEnterprise Shop records the details of each connection in 
the event log file on your computer. Normally, the process should finish successfully but 
occasionally there may be errors or problems with the process. 

Reviewing the collection process includes the following tasks:

checking results of the collection process by viewing the connection event log 

following up on any problems or errors in the connection event log 

starting the collection process manually, if necessary.
C H A P T E R  3 U S I N G  R E T A I L E N T E R P R I S E  S H O P



To view the connection event log

To view the details in the connection event log file, perform the following steps:

1 Go to the Tools menu and choose Connection Event Logs. The Connection Event Logs 
window appears.

2 Specify the date range—typically yesterday and today’s date if you are checking for last 
night’s processing.

To change the range of dates displayed:
a In the Start Date field, click the down arrow and select the required start date from the 

calendar list.
b In the End Date field, click the down arrow and select the required end date from the 

calendar list.

3 Click Refresh to view the event log details for the new date range.

4 If you notice that there are no connections to central office or there is some other 
discrepancy, you will need to check the connection setup. This may include any or all of the 
following:

checking the computer connection details for your shop. This is done from central office. 
See the Using RetailEnterprise Central chapter of the MYOB RetailEnterprise Central User 
Guide.
contacting the individual shop to determine if the computer and modem are correctly 
connected.

5 Click Close to close the Connection Event Logs window.
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Receiving product updates from central office

central office maintains the product database and can send product updates to the shops. 
Typically these updates would include:

new products

price updates.

With any product update, you have the option of either accepting or rejecting the proposed 
changes depending on various factors such as whether:

your organisation has a central pricing policy

the changes are applicable to your shop. 

Your central office should send a message to notify shops of forthcoming product updates. 
When you get notification of centralised product updates for your shop, decide on a suitable 
time to process the pending updates. You cannot apply changes to your stock file items while 
they are being accessed by RetailManager in processing retail transactions.

You can either choose a time outside normal business hours, or halt all retail transactions while 
you process the product updates. It should only take a few minutes to process the centralised 
product updates as described below.

CAUTION : Keep data consistent with RetailManager It is important to keep supplier details and 
tax codes consistent with your Central database.

The process of receiving and loading product updates involves steps through RetailEnterprise 
Shop and RetailManager.

The product updates process is documented in the following table.

Step Procedure

At central office

Send messages and product update to shops. See the Using RetailEnterprise Central chapter of the MYOB 
RetailEnterprise Central User Guide.

At Shop

Step 1 Check for new messages received in RetailEnterprise Shop. See ‘To read a message’ on 
page 34.

Step 2 Check product update has arrived in RetailEnterprise Shop (Transfers > Transfer Audit). 
See ‘To display all transfers between your shop and central office’ on page 39.

Step 3 Open shopfront in RetailManager. See the Setting Up chapter of the MYOB RetailManager 
User Guide.

Step 4 View product updates in RetailManager (Stock Management > Centralised Updates). See 
step 4 on page 45.

Step 5 Accept or reject stock list items for update. See step 7 on page 46.
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To review centralised product updates

NOTE : Perform a backup You may find it useful to make a backup of your RetailManager shopfront 
database before you accept a centralised product update in case you need to revert to your previous 
data. See the Administration chapter of your MYOB RetailManager User Guide.

1 Each shop is usually advised by central office that a centralised update is waiting. 
A message similar to the following appears in RetailEnterprise Shop.

2 Double-click the message to read it. It may have information about the update.

3 Go to the Transfers menu and choose Transfer Audit. The Transfer Audit window 
appears.

You may need to change the Audit Filters and click Refresh if you have many messages in 
the list and can’t immediately see the update message. (See ‘To display all transfers 
between your shop and central office’ on page 39.)

The next step in loading a centralised update occurs in RetailManager.

Step 6 Load update into RetailManager. See step 10 on page 46.

Step 7 View and print report. See step 12 on page 47.

Step Procedure
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To load centralised product updates

1 Start RetailManager if it is not already running.

If you have more than one shopfront database, you will need to select the database that is 
to receive the update from the list that appears when you start RetailManager.

2 In RetailManager, go to the Stock Management menu and choose Centralised Updates. 
The following message appears:

3 Close any other retail terminals that are running RetailManager, and then click Yes. The 
MYOB RetailEnterprise Centralised Updates window appears. 

The product update can have a status of:

Pending—Update records have not been processed.

Partial—Stock item(s) were rejected due to an invalid tax code or excluded from the load. 
The stock item will be set with the status of either Rejected or Cancelled after loading.

Processed—All associated stock items have been loaded successfully.

If the product update is displayed in italics, it consists of selected invalid stock items.
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4 Select the update and click Stock List. The MYOB RetailEnterprise Centralised Updates 
- Product Updates window appears.

This window displays a list of the stock items to be updated.

5 Double-click an item to view its details.

NOTE : No update records found If there are no available updates, a text message is displayed 
on the grid: ‘No update records found.’ The Stock List, Load and Delete buttons are disabled 
when there are no records.

HOW TO INTERPRET THE LIST

Stock items can have different statuses.
Pending—Stock items have not been processed.
Partial—Stock items were rejected due to an invalid tax code or excluded from the load. 
The stock item will be set with the status of either Rejected or Cancelled after loading.
Processed—All associated stock items have been loaded successfully.
Stock items can appear in a colour.

If a stock item in the list is in red, it means that the record is invalid for some reason, 
for example, it has an invalid tax code ( ). Double-click that item to 
view it and find the problem.
If a stock item in the list is in blue, it means that it is a new item 
( ). Double-click that item to view the details.

6 Review the product update details.
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7 Select the product updates that you want to accept in your shop.
To select all the product update lines displayed, click the Select column heading in the 
MYOB RetailEnterprise Centralised Updates window.
To select a particular product update line, select the Include option on that item in the 
MYOB RetailEnterprise Centralised Updates - Product Updates window.
To reject a particular product update line, deselect the Include option on that item in the 
MYOB RetailEnterprise Centralised Updates - Product Updates window.
To reject the entire update, click Delete in the MYOB RetailEnterprise Centralised 
Updates window.

When you have made your selections, ensure you have selected only the product updates 
that are applicable to your shop. 

8 If required, you can print a product update before loading it:
a In the MYOB RetailEnterprise Centralised Updates window, select the product 

update.
b Go to the File menu and choose Print. The update appears in the report viewer. 
c Click the print icon ( ) to print the product update report. 

9 Click Save if you have made any changes and then click the close icon ( ). The MYOB 
RetailEnterprise Centralised Updates window appears.

10 Click Load to start the centralised update. 
If an earlier update record is found, the load process will terminate and display an 
information window. Click OK to return to the MYOB RetailManager Centralised 
Updates window and retain the selected records. The update record will retain the status 
of ‘Pending’.
You should process the updates in job order to ensure the shop database is kept 
consistent with the database at central office.
If there are no stock items in the product update, a window advising you of this appears. 
Click Yes to process the update or click No to terminate the update.
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11 The following message appears when the update is completed. Note that the status of the 
product update also changes to ‘Processed’.

12 Click OK. The report viewer displays the details of the product update.

This shows the number of stock items updated and the number (if any) of records rejected 
from the product update. If selected product updates are valid, they are saved to your 
shopfront database in RetailManager.
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The most likely cause of an invalid product item update is if your RetailManager stock 
database is not consistent with your central office product database. This can happen if 
you modify a stock item in RetailManager by changing one of the following fields: bar 
code, description, department or category. In this situation, we recommend that you do 
one of the following:

Contact your central office and discuss how to keep the two databases consistent.
Contact an MYOB RetailManager Professional for assistance.

13 Click the print icon ( ) to print the report or click the close icon ( ) to close the viewer.

14 Click Close to close the MYOB RetailEnterprise Centralised Updates window.

You can now reopen your RetailManager shopfront and retail terminals.

Managing your shop database

It is important to safeguard your shop database by backing it up regularly and depending on 
your business activity, this could be daily. The more regular your backups, the less data you 
may lose if there is a problem with either your computer or the database file.

To back up your shop database

1 Go to the File menu and choose Settings. The Settings window appears.

2 If required, change the backup location in the Backup Path field.

You can either enter the new backup path, or click Browse to select the path from the 
Open window.

3 Click Backup. The Save As window appears. 

4 Enter the name for the backup file or accept the suggested name (which is based on the 
date). If you are saving to another medium you must specify the entire path, for example, 
e:\Backups\RME040429.

5 Click Save to perform the backup and close the Settings window.

RetailEnterprise Shop makes a zipped, backup copy of your shop database in the location 
specified in the Backup Path field.
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Storing your backup data It’s good practice to store your backups on removable media 
such as an external hard drive or a CD, and preferably at another physical location. If your PC 
fails or there is a fire for example, it’s no use at all to have the backup on your c:\ drive or on 
a disk on your desk.

To restore your shop database

If you need to restore your central database in RetailEnterprise Shop, use your most recent 
backup file. 

Note that RetailEnterprise Shop must not be running a process on your central computer while 
you are restoring your database.

NOTE : Reenter information after restore You will need to reenter any transaction information 
that has occurred since you created your backup databases.

1 Go to the File menu and choose Settings. The Settings window appears.

2 Click Restore. The Select File to Restore window appears.

3 Select the backup file you want to restore. 

4 Click Open. RetailEnterprise Shop restores the database. 

A message informing that the database was successfully restored appears.

5 Click OK.
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4  Using Stock At 
Other Shops

The Stock At Other Shops feature is a separately installed program that is included with 
RetailEnterprise Shop. Stock At Other Shops allows you to view the stock holdings of other 
shops in a RetailEnterprise network.

Stock levels in other shops cannot be modified remotely by another shop.

Stock At Other Shops operation

RetailEnterprise Central performs a regular collection of information from shops in an 
Enterprise network, including (if set up) summary sales information and current stock holdings 
at each shop.

When the collection has been completed, RetailEnterprise Central then passes other shop 
stock-holding information back to each shop in the Enterprise network. 

A RetailEnterprise Shop user can then view stock holdings at other shops, perform searches on 
other stock holdings and if required, display shop details, such as the name, address and 
contact details.

NOTE : Shop Details Shop details information is set using MYOB RetailEnterprise Central. 

Installing MYOB RetailEnterprise Stock At 
Other Shops

Before you install Stock At Other Shops
You need to have MYOB RetailEnterprise Shop installed and accessible from the computer you 
use for Stock At Other Shops.

NOTE : Where to install Stock At Other Shops You do not need to install Stock At Other Shops on 
the same computer as you have installed MYOB RetailEnterprise Shop, but you do need to have LAN 
access to the computer on which your RetailEnterprise Shop database is stored.
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To install MYOB RetailEnterprise Stock At Other Shops

You install MYOB RetailEnterprise Stock At Other Shops using your MYOB RetailEnterprise 
Shop CD.

1 Before you start, close all open applications. This is very important for correct installation.

2 Log in as an Administrator (for Windows Vista users), or as an Administrator or Power User 
(for Windows XP or 2000 users whose computers only allow people with administrator 
privileges to install programs).

NOTE : Logging into Windows Vista as a Standard user If you have the Administrator 
password, you may be able to log into Windows Vista as a Standard user. You can then install 
RetailEnterprise Stock At Other Shops.

3 Insert either the MYOB RetailEnterprise Shop CD and wait a few moments. A welcome 
window appears.

If a welcome window does not appear automatically:

The welcome window appears. If the welcome window still does not appear, double-click 
the autorun.exe file.

4 Select the installer:
[Australia and New Zealand] Click Install RetailEnterprise Stock At Other Shops. 
[Hong Kong, Malaysia and Singapore] Click Select RetailEnterprise Stock At Other 
Shops installer, and then select the installer for your country.

The Welcome to MYOB RetailEnterprise Stock At Other Shops v4 Setup window 
appears. 

5 Follow the onscreen instructions.

NOTE : Warnings If any warnings appear during installation, see ‘Troubleshooting your 
installation’ on page 53. 

6 When the Installation Complete window appears, click Finish.

You do not need to restart your computer.

A shortcut to RetailEnterprise Stock At Other Shops is automatically created on your 
desktop. 

NOTE : Install Adobe Reader to view PDF versions of the user guides You will need to install 
Adobe Reader to view the PDF versions of the user guides provided with your software.
To install Adobe Reader, click Resources in the welcome window of the MYOB RetailEnterprise 
Shop v4 CD.

If you are using... do this...

Windows Vista 1 Go to the Start menu and click Computer.

2 Click your CD or DVD drive icon (usually labelled D:\ 
or E:\) in the right pane of the Computer window.

Windows XP or 2000 1 Go to the Desktop and double-click My Computer.

2 Double-click your CD or DVD drive icon (usually labelled D:\ 
or E:\) in the right pane of the Computer window.
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Troubleshooting your installation
During the installation of RetailEnterprise Shop, it is possible that you may get the following 
warnings or error messages.

For help with resolving other installation issues, contact technical support. For more 
information see ‘MYOB technical support’ on page 59.

Starting Stock At Other Shops

When you start Stock At Other Shops, an automatic check is performed to see if you have 
RetailEnterprise Shop installed on your local computer.

If the RMShop database is not found, see ‘Connecting to your RMShop database’ on 
page 54.

If the RMshop database is found, Stock At Other Shops automatically connects to the 
RMShop database, and the MYOB RetailEnterprise Stock At Other Shops window 
appears.

If the following warning 
message appears...

do this...

Read Only File Detected Select the Don’t display this message again option and click Yes. The 
application will continue to install.

Locked File Detected Select the Don’t display this message again option and click Reboot. 
The application will continue to install.

Files Failing to Self-Register Click OK. This warning does not affect the installation of the software.
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Connecting to your RMShop database
If you have installed Stock At Other Shops on a computer that does not have RetailEnterprise 
Shop installed, the MYOB RetailEnterprise Stock At Other Shops window appears with a 
message informing you that the RMShop database is not connected.

To connect to your RMShop database

1 Go to the File menu and choose RMShop Location.

The Locate the MYOB RetailEnterprise - Shop database window appears.
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2 Select the RMShop.mdb file, and click Open.

The MYOB RetailEnterprise Stock At Other Shops window appears.

You can now view the stock holdings at other shops.

Managing Stock

Using Stock At Other Shops, you can select a particular stock item from your inventory and see 
if other shops in your RetailManager network have the same stock item in their inventory.

Details are provided so you can contact other shops in your RetailEnterprise network should 
you need to arrange pick up of a particular stock item, or wish to determine whether a 
particular shop still has the item in stock. 

Searching for stock items
You search for stock items in Stock At Other Shops in the same way as you perform searches in 
any other RetailManager product.

The Stock list displays all the stock items you have in your RetailManager inventory.

Click column headings in the Stock list to sort stock information in alphabetical order based on 
the data in that column.
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To search for a stock item in your inventory

You can search for a particular stock item in your inventory using Stock At Other Shops.

1 In the MYOB RetailManager Stock At Other Shops window, click the down arrow above 
the Stock list to select a type of search.

You can choose to search by bar code, description, department or category.

2 In the Like text box, type the first few letters or a complete bar code, description, 
department or category you want to match in your search, and click Search.

Leave the Like text box blank and click Search to see all items for a particular type of 
search.

3 Select the display line for a particular stock item.

The bar code and description of the product appear below the Stock list.

When a selected stock item in the Stock list is available in another shop or shops, a list of 
shops that have this stock item appears in the Shops area of the MYOB RetailEnterprise 
Stock At Other Shops window.

If no shops in your RetailEnterprise network have the selected stock item, a message 
informing you that no shops have the stock item appears in the Shops list.

Displaying details of another shop
When a stock item is selected, and other shops in your RetailEnterprise network also have this 
stock item in their inventory, shop details appear in the Shops area of the MYOB 
RetailEnterprise Stock At Other Shops window.
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Shop details shown in this window are the:
name of the shop
name of the contact person
quantity of the item in stock
average number of sales per day of this item
last time a stock item was sold at that shop
effective date, that is, the last time stock information for the displayed shop was collected.

To display contact details

Double-click a Shops List display line. The Shop Details window appears.

You can use this information to directly contact the shop.
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Appendix A: MYOB 

technical support
Our technical support team can offer assistance with installing, using and troubleshooting 
MYOB RetailEnterprise Shop. However, support cannot be provided on issues arising from 
hardware or operating system faults, or incompatible hardware or software. You may need to 
contact an MYOB RetailManager Professional if these issues arise.

Technical support options for your region

Prepare before you call technical support

Gather information about the problem

Try to recall and write down details of the problem, including what you did before the 
problem occurred, and the exact text of any error message that appeared. See if you can 
reproduce the problem.

Gather the following information about your software

The serial number, which is printed on the RetailEnterprise Central CD sleeve or 
registration form. To check this in the software, go to the Help menu and select Company 
Details.

The version of the software, which is printed on the RetailEnterprise Central CD sleeve. To 
check this in the software, go to the Help menu and select About MYOB RetailEnterprise.

If you’re in... See...

Australia page 60

New Zealand page 62

Hong Kong page 63

Malaysia page 64

Singapore page 65
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Gather the following information about your computer

Your computer type, processor and model, and the version number of the operating 
system you are running. To locate this information, do the following:

Australia

Technical support phone numbers and charges

If you are using... do this...

Windows Vista 1 Go to the Start menu.

2 Right-click Computer and choose Properties. The System window 
displays the hardware and operating system details.

Windows XP or 
2000

1 Right-click the My Computer desktop icon.

2 Choose Properties and then click the General tab. The System 
Properties window displays the hardware and operating system details.

Support Plan Phone number Available times (EST) Charges

Retail Enhancement 
and Support

1300 555 115 9.00am to 7.00pm
(Monday to Wednesday)
9.00am to 9.00pm
(Thursday to Friday)
9.00am to 5.00pm 
(Saturday to Sunday)

 Local call charges

Pay-Per-Call Support
If your introductory 
support period has 
expired and you are 
not subscribed to Retail 
Enhancement and 
Support.

1300 555 128 9.00am to 7.00pm
(Monday to Friday)

Local call charges and 
Pay-Per-Call charges. 
To find out what our 
current Pay-Per-Call 
charges are, call 
1300 555 115.
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Technical support options

Retail Enhancement and Support

Maintaining your Retail Enhancement and Support subscription provides you with:

technical support seven days a week

all upgrades and updates we release for your product

regular communications including Coverage, or monthly e-newsletter

exclusive discounts and special offers.

On expiry of your initial subscription, the Retail Enhancement and Support subscription can be 
renewed at your expense.

For the terms and conditions of Retail Enhancement and Support, visit myob.com.au/retail 
and click MYOB RetailEnterprise. From the Quick Links section on the right side of the page, 
click Support plans for businesses and then click MYOB Retail Enhancement and Support.

Pay-Per-Call support

If you do not renew your Retail Enhancement and Support subscription, you can access 
technical support on a Pay-Per-Call basis. Pay-Per-Call support is charged at a per-minute rate 
and a minimum charge applies. Prices and conditions are subject to change without notice 
and are available from MYOB by calling 1300 555 115.

Support notes

You can access a wide range of technical support notes at myob.com.au/supportnotes

Keep up to date with RetailEnterprise on the Web

The MYOB website (myob.com.au/retail) is updated frequently and contains the latest 
RetailEnterprise information, news, and links to many useful resources.

Send us your feedback

We welcome your suggestions for improvements and changes to RetailEnterprise. Go to 
myob.com/ideas and complete the online form.
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New Zealand

Technical support phone numbers and charges

Technical support options

BusinesSUPPORT

Maintaining your businesSUPPORT subscription provides you with:

Automatic software upgrades—automatically upgrade to a new version of your MYOB 
RetailManager product when it is released during the course of your subscription, keeping 
your business up to date with the latest retail business management technology.

Quarterly issues of MYOB InFocus—a year’s subscription to the quarterly publication 
written by MYOB Technical Communications specialists, providing you with tips and 
techniques to help you get the most out of your retail business management and 
accounting system.

0508 number access to MYOB technical support—telephone a technical support 
specialist for advice about your MYOB RetailManager software.

Email access to MYOB technical support—email a concise and accurate description of 
your technical issue to the technical support email address. MYOB will usually reply by the 
next business day.

Fax access to MYOB technical support—fax a concise and accurate description of your 
technical issue to the technical support address. MYOB will usually reply by the next 
business day.

Notification of and access to regularly-updated web-based MYOB support 
notes—combine an up-to-date subscription with an up-to-date email address to receive 
notice of the latest software support information online.

For the terms and conditions of businesSUPPORT, visit myob.co.nz, click Support, then click 
Business Owners and then click Join MYOB businesSUPPORT.

Support notes

You can access a wide range of technical support notes at myobnz.custhelp.com

Support Plan Phone number Available times Charges

RetailManager 
businesSUPPORT

By subscription only

0508 123 123 9.00am to 5.00pm
(Monday to Wednesday),
9.00am to 9.00pm
(Thursday and Friday) 
and
11.00am to 5.00pm
(Saturday and Sunday)

Calls are free when 
subscription is paid. 
(Subscription fee can 
only be paid via direct 
debit.)
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Send us your feedback

We welcome your suggestions for improvements and changes to RetailEnterprise. Go to 
myob.com/ideas and complete the online form.

Hong Kong

Technical support phone numbers and charges

Technical support options

Retail Enhancement and Support

Maintaining your Retail Enhancement and Support subscription provides you with:
priority telephone technical support five days a week
fax and email technical support, with an answer by the next business day
all upgrades and updates we release for your product
exclusive discounts and special offers.

The purchase price of your MYOB RetailManager software includes one year’s subscription to 
Retail Enhancement and Support.

When your initial subscription to Retail Enhancement and Support expires, you can renew 
your subscription if you want.

NOTE : Your subscription to Retail Enhancement and Support starts from the date you register 
MYOB RetailManager.

Support notes 

You can access a wide range of technical support notes online.

1 Go to the MYOB website at myob.com.hk

2 Click the Support tab.

3 In the Business Management products section, click 
Support Notes and Advanced Academy.

Send us your feedback

We welcome your suggestions for improvements and changes to RetailEnterprise. Go to 
myob.com/ideas and complete the online form.

Support Plan Phone number Available times Charges

Retail Enhancement 
and Support

(852) 3402 9888 9.30am to 6.00pm 
(Monday to Friday)

For information about 
call charges, contact 
technical support.
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Malaysia

Technical support phone numbers and charges

Technical support options

MYOB Business Support

Maintaining your MYOB Business Support subscription provides you with:
priority telephone technical support five days a week
fax and email technical support, with an answer by the next business day
all upgrades and updates we release for your product
exclusive discounts and special offers.

The purchase price of your MYOB RetailManager software includes three months’ subscription 
to MYOB Introductory Support.

When your initial subscription to MYOB Introductory Support expires, you can subscribe to 
MYOB Business Support if you want.

NOTE : Your subscription to MYOB Introductory Support starts from the date you register MYOB 
RetailManager.

Support notes 

You can access a wide range of technical support notes online.

1 Go to the MYOB website at myob.com.my

2 Click the Support tab.

3 In the For Businesses section, click Technical Support Notes.

Send us your feedback

We welcome your suggestions for improvements and changes to RetailEnterprise. Go to 
myob.com/ideas and complete the online form.

Support Plan Phone number Available times Charges

MYOB Business 
Support

(603) 8991 0188 or 
1300 88 6962 (The 
latter number is for 
customers outside 
the Klang Valley 
region. Calls to this 
number are charged 
at the local call rate.)

9.00am to 5.30pm 
(Monday to Friday)

For information about 
call charges, contact 
technical support.
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Singapore

Technical support phone numbers and charges

Technical support options

MYOB Business Support

Maintaining your MYOB Business Support subscription provides you with:
priority telephone technical support five days a week
fax and email technical support, with an answer by the next business day
all upgrades and updates we release for your product
exclusive discounts and special offers.

The purchase price of your MYOB RetailManager software includes three months’ subscription 
to MYOB Introductory Support.

When your initial subscription to MYOB Introductory Support expires, you can subscribe to 
MYOB Business Support if you want.

NOTE : Your subscription to MYOB Introductory Support starts from the date you register MYOB 
RetailManager.

Support notes 

You can access a wide range of technical support notes online.

1 Go to the MYOB website at myob.com.sg

2 Click the Support tab.

3 In the For Businesses section, click Technical Support Notes.

Send us your feedback

We welcome your suggestions for improvements and changes to RetailEnterprise. Go to 
myob.com/ideas and complete the online form.

Support Plan Phone number Available times Charges

MYOB Business 
Support

(65) 6505 6584 9.00am to 5.30pm 
(Monday to Friday)

For information about 
call charges, contact 
technical support.
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6 6   
MYOB training options

MYOB RetailManager Professionals

NOTE : In this document, MYOB Point of Sale Specialists [New Zealand], MYOB POS Partners 
[Hong Kong] and MYOB Professional Partners [Malaysia and Singapore] are referred to as MYOB 
RetailManager Professionals.

MYOB RetailManager Professionals provide independent on-site assistance with MYOB 
RetailEnterprise and associated products and services, including:

Retail business system needs and analysis

RetailEnterprise installation, setup and implementation 

Point-of-sale hardware and peripheral solutions

On-site training and support for RetailEnterprise

RetailEnterprise database maintenance

Integration with MYOB business management software.

As independent businesses, MYOB RetailManager Professionals offer a range of services.

For more information or a list of MYOB RetailManager Professionals, go to myob.com, choose 
the link for your region and click Partners.

MYOB training and MYOB Approved Training Providers

NOTE : MYOB training is not available in Hong Kong.

If you want to know more about the new features in MYOB RetailManager or how 
RetailManager can improve the profitability of your retail business, enrol in an MYOB 
RetailManager course. An MYOB RetailManager course will show you how to set up your 
system correctly from the start, and how to use RetailManager’s many features to help you 
improve your store’s sales performance. You’ll be trained using the latest version of 
RetailManager by MYOB professional trainers.

[Australia only] In addition to an MYOB RetailManager training course, independent 
classroom-based training is available through our network of MYOB Approved Training 
Providers. 

For more information about your training options, go to myob.com, choose the link for your 
region and click Training + Events.
A P P E N D I X  A : M Y O B  T E C H N I C A L  S U P P O R T
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